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Conventions Used in this Guide

Please take a moment to review how instructions and other useful information are presented in
this documentation.

l Procedures are presented as numbered lists. A single bullet indicates that the procedure
has only one step.

l Bold type is used for the following:
o Keyboard entries that should be typed in their entirety exactly as shown. For
example, “copy file1” means you must type the word copy, then type a space, and
then type file1.

o On-screen prompts and messages, names of options and text boxes, and menu
commands. Menu commands are often separated by greater than signs (>). For
example, “click HFSS > Excitations > Assign >Wave Port.”

o Labeled keys on the computer keyboard. For example, “Press Enter” means to
press the key labeled Enter.

l Italic type is used for the following:
o Emphasis.
o The titles of publications.
o Keyboard entries when a name or a variable must be typed in place of the words in
italics. For example, “copy filename” means you must type the word copy, then
type a space, and then type the name of the file.

l The plus sign (+) is used between keyboard keys to indicate that you should press the
keys at the same time. For example, “Press Shift+F1” means to press the Shift key and,
while holding it down, press the F1 key also. You should always depress the modifier key
or keys first (for example, Shift, Ctrl, Alt, or Ctrl+Shift), continue to hold it/them down, and
then press the last key in the instruction.

Accessing Commands: Ribbons, menu bars, and shortcut menus are three methods that can
be used to see what commands are available in the application.

l The Ribbon occupies the rectangular area at the top of the application window and con-
tains multiple tabs. Each tab has relevant commands that are organized, grouped, and
labeled. An example of a typical user interaction is as follows:

"Click Schematic > Line"
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This instruction means that you should click the Line command on the Schematic ribbon
tab. An image of the command icon, or a partial view of the ribbon, is often included with
the instruction.

l Themenu bar (located above the ribbon) is a group of the main commands of an applic-
ation arranged by category such File, Edit, View, Project, etc. An example of a typical user
interaction is as follows:

"On the Filemenu, click theOpen Examples command" means you can click the File
menu and then clickOpen Examples to launch the dialog box.

l Another alternative is to use the shortcut menu that appears when you click the right-
mouse button. An example of a typical user interaction is as follows:

“Right-click and select Assign Excitation> Wave Port” means when you click the right-
mouse button with an object face selected, you can execute the excitation commands
from the shortcut menu (and the corresponding sub-menus).

Getting Help: Ansys Technical Support

For information about Ansys Technical Support, go to the Ansys corporate Support website,
http://www.ansys.com/Support. You can also contact your Ansys account manager in order to
obtain this information.

All Ansys software files are ASCII text and can be sent conveniently by e-mail. When reporting
difficulties, it is extremely helpful to include very specific information about what steps were
taken or what stages the simulation reached, including software files as applicable. This allows
more rapid and effective debugging.

Help Menu

To access help from the Help menu, click Help and select from the menu:

l [product name] Help - opens the contents of the help. This help includes the help for the
product and itsGetting Started Guides.

l [product name] Scripting Help - opens the contents of the Scripting Guide.
l [product name] Getting Started Guides - opens a topic that contains links to Getting
Started Guides in the help system.

Context-Sensitive Help

To access help from the user interface, press F1. The help specific to the active product (design
type) opens.

You can press F1 while the cursor is pointing at a menu command or while a particular dialog
box or dialog box tab is open. In this case, the help page associated with the command or open
dialog box is displayed automatically.
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1 - Introduction
This example builds on the project developed in Tutorial 1 to introduce additional modeling con-
cepts and features in EMIT. You can find a completed version of the Tutorial 1 project in the
installed examples directory by clicking onOpen Examples in the Desktop ribbon toolbar.

Key Concepts
l Building and analyzing scenarios with multiple Tx’s and Rx’s
l EMIT’s N-on-1 analysis mode
l Outboard amplifiers
l Interference due to intermodulation effects

Project Configuration
For this example, we will again modify the project built in Tutorial 1. Load that project into EMIT
and

save it as “Tutorial 3” by selecting Save As from the File menu.

We will be adding several additional RF systems to this project and examining the effect of mul-
tiple Tx’s operating simultaneously and their effect on a victim Rx. Along the way we’ll explore
various mitigation strategies to combat interference, eventually arriving at a completely inter-
ference-free scenario. The final scenario is shown notionally in the figure below. Note that since
we are still using a fixed value (Global Default Coupling = -40 dB in this case) of coupling
between all antennas, the actual physical location of the antennas is irrelevant (Tutorial 4
explores EMIT’s other antenna-to-antenna coupling models).

Up until now we have only looked at the effects of a single Tx on a Rx. When we look at multiple,
simultaneously operating Tx’s on a victim Rx, we not only have to account for the direct signal
from each Tx combining at the Rx antenna, but also the effects of inter-Tx coupling – that is, of
signals coupling between the Tx’s and re-radiating to the victim Rx. This is of concern because
when multiple signals couple into the front-end of a Tx, nonlinear effects in the Tx’s power amp-
lifier (PA) can generate undesired intermodulation products that can cause interference even
when the individual signals do not. We will see this first-hand during this example.

Introduction 1-1
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2 - Add a Transceiver (RT) to the Scen-
ario and Mitigate Interference

To begin, we will add a Radio to the scenario. Select the Schematic tab in the ribbon toolbar and
then add a New Radio from the Radio drop-down menu. Select the new radio and in the Prop-
erties panel and rename it RT-2.

Double-click on the radio in the schematic or right-click and select Configure to configure the
radio. Rename the New Radio node RT-2 (Hi-UHF). Then set the parameters for the Band, Tx
Spectral Profile and Rx Spectral Profile as shown below, being careful to copy all the parameters
as shown. Note that the Tx Broadband Noise = -185 dBm/Hz. This is clearly below the the-
oretical noise floor limit of -174 dBm/Hz and is only configured this way to simplify the results ana-
lysis later on in this example.

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-1
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We also want to model the IF frequency, mixer products, and IF filters for this Band. Right-click
on the Rx Spectral Profile and select Add Mixer Products. Then right-click on the Rx Spectral
Profile node and select Rx Selectivity. Configure these nodes as shown below.

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-2
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Next, select the Sampling for the RT-2 (Hi-UHF) radio and set the values as shown below.

ClickOK to close the Radio Configuration dialog. Next, use the ribbon toolbar to add an antenna
to the RT-2 radio. If the antenna is not automatically connected to the output port of the RT-2
radio, then reposition it. The schematic should appear as shown below.

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-3
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Before continuing, we want to modify our antennas so that they do not contribute any ambient
noise to the simulation results (for simplicity). Double-click on one of the antennas in the schem-
atic to open the Coupling Editor.

Set the Antenna Temperature = 0 K in the property panel for the selected antenna. Then repeat
for the other two antennas.

ClickOK to close the Coupling Editor. From the Simulation tab of the ribbon toolbar, select Ana-
lyze to open a results dialog box.

Move the N to 1 Combination Limit slider to the left.

By default, self-interactions for transceivers are enabled. That is, transceivers can interfere with
themselves. This can be changed to exclude RT self-interaction in the analysis by right-clicking

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-4
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on a self- interaction square in the Scenario Matrix and deselecting Enabled. In this example,
there is no external path from the RT-2 transmitter to the RT-2 receiver and therefore it has a
warning in the Scenario Matrix. Since we are not interested in the transceiver’s self-interference,
right-click on the RT-2 self- interaction square and deselect Enabled. The Scenario Matrix
should now appear as shown below.

Note: The [N to 1] column for Rx-0 (UHF) is automatically enabled since there is a valid
N-to-1 simulation for this receiver.

Any analysis corresponding to a square in the threat matrix can be toggled between active and
inactive by clicking on the square while holding down the control key or by right-clicking on the
square and selecting (or deselecting) the Enabled option. In this way, the specific analyses that
are run by EMIT can be easily controlled.

In some cases, we may wish to have EMIT flag EMI margins that are less than zero in order to
build a safety margin of sorts into the analysis or flag EMI margins above a certain threshold
(e.g. +50 dB) as “critical” EMI problems. For this project, we will have EMIT flag any EMI margins
< -10 dB as interference free (green), EMI margins between -10 dB and 0 dB as marginal (yel-
low), and EMI margins > 0 dB as interference (red). To do this select the By EMI Margin tab in
the upper right corner of the Results dialog box. If the values on this tab do not match these set-
tings, then reconfigure them now.

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-5
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Run all the analyses by clicking on the icon in the toolbar at the top of the Results dialog. The
Scenario Matrix is shown below. Recall that the pop-up showing the Max EMI margin for any
flagged entry in the threat matrix can be obtained by hovering the cursor over the square
momentarily.

From the threat matrix, we see that when RT-2 transmits at 835 MHz there is the potential for
interference with a -10 dB EMI margin in Rx-0, which is operating at 500 MHz. To further invest-
igate this issue, we will use some of the other displays in the Results dialog, notably the Results

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-6
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Plot. By default, the Results Plot will show the worst-case interference for the square that is
selected in the Scenario Matrix. If no square is selected, then the worst-case interference for the
entire scenario will be displayed. If the square for the RT-2 vs Rx-0 (UHF) interaction is not
already selected, then do so now and observe any changes in the Results Plot.

Note that you can change the line width on the traces in the plot by clicking on the legend labels
at the bottom, below the plot. For example, click on the “Receiver Susceptibility” legend name
and the blue Rx susceptibility trace in the plot will be highlighted as shown below. By doing this
for various traces it is easy to identify where spectral features overlap. In this case, we see that
the Tx fundamental falls within a low-level Rx spurious response at 835 MHz which is the cause
of the interference. This would be considered out-of-channel interference since the interfering
signal is outside the Rx’s tuned channel bandwidth.

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-7
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Aside from reducing the Tx power, there isn’t anything that can be done at the Tx (RT-2 in this
case) to mitigate the problem. Any mitigation must take place at the Rx. In this case we can add
a bandpass filter to the Rx to prevent the out-of-channel signals from getting into the Rx front-
end. Click the “X” in the upper corner of the Results dialog to return to the schematic. Note that
EMIT automatically saves the results and that they will not be lost. To view the results again,
simply right-click on the result in the Project Tree and select Show Result. Note that your revi-
sion number may be different.

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-8
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If changes are made to a project, any existing results will become invalid and shown in the pro-
ject tree with a red “X”. The results for that node can still be viewed and represent a snapshot of
the scenario at that instant. To help organize and maintain multiple results, EMIT allows each
result node to be renamed and for notes to be added. Right-click on the existing result node and
select Rename (again, it may not be named Revision 72). Name the result Preliminary Analysis.
Then in the Properties panel, select Edit Notes and add some comments that describe the cur-
rent scenario and results.

Next, we want to add a bandpass filter at the output of Rx—0 (UHF) to mitigate the interference
we observed. To do this, drag Antenna 2 to the left of Rx-0 (UHF) and release the left mouse but-
ton. This will delete the wire connecting the radio and antenna. Then select the Rx-0 (UHF) radio
in the schematic and the add a Band Pass filter from the Filter drop down menu. These steps
should ensure that the filter automatically gets placed and connected at the radio’s output. Fin-
ally, select Antenna 2 and then click Reposition in the Schematic ribbon toolbar. Since the right-
side port of the bandpass filter is the only unconnected port, Antenna 2 will automatically be
repositioned and connected here. The schematic should now show:

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-9
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In the Properties panel, set the bandpass filter’s name to UHF Bandpass Filter. Then right-click
on the bandpass filter (Filter 2 above) and select Configure. Set the filter’s parameters as
shown below and then clickOK to close the edit dialog.

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-10
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Fromthe Simulation tab of the ribbon toolbar, select Analyze to open the Results window. Note
that the initial results are now marked as “invalid” and a new results node has been added (the
revision numbers may not match).

In the results window, re-run the simulation. The Scenario Matrix should now have all green
squares, signifying that all the current interference problems were mitigated. Close the results
dialog using the “X” in the upper right corner and rename the results node Preliminary Analysis –
Mitigated.

Add a Transceiver (RT) to the Scenario and Mitigate Interference 2-11

Ansys Electromagnetics Suite 2024 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Getting Started with EMIT - Tutorial 3

3 - Add Additional Txs to the Scenario
We will now add two additional transmitters to the scenario and include an outboard power amp-
lifier on one of them. From the Schematic tab in the ribbon toolbar, select New Radio from the
Radio drop down menu and name the radio Tx-3 (Lo-UHF). To configure the radio so that it is a
transmitter only, right-click and open its Configuration dialog. Then, expand the Band node and
disable the Rx Spectral Profile. Finally, set its operating parameters as shown in the Band, Tx
Spectral Profile and Sampling nodes below. After entering the parameters, clickOK to close the
Configuration dialog box.

Add Additional Txs to the Scenario 3-1
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Repeat the above steps to add another radio named Tx-4 and set its parameters as shown
below.

Note the relatively low (10 dBm) power level of Tx-4 indicating that it is a low-level exciter. We
want to add an external RF power amplifier to this transmitter to boost the power. In the Schem-
atic ribbon toolbar, click the Amplifier icon to insert an amplifier. If it is not connected to Tx-4,
then click Reposition to automatically move it. Double-click on the new amplifier to configure it
with the parameters below. Detailed explanations for each of these parameters can be found in
the amplifier section of the EMIT help. Clicking Help ( ) above the amplifier’s property panel will
take you directly to the amplifier online help.

Add Additional Txs to the Scenario 3-2
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Before continuing with the analysis, we will examine the characteristics and features of the amp-
lifier in some additional detail. EMIT’s amplifier model takes into account the nonlinear behavior
of the amplifier. When multiple signals are present at the input of the amplifier, not only do amp-
lified versions of those signals appear at the output, but intermodulation products (intermod) gen-
erated by the nonlinear characteristics of the amplifier are also generated and appear at the
output. Further, the model uses the reverse isolation of the amplifier to account for signals enter-
ing the output of the amplifier. This is very important to include for cosite interference predictions
since it is the mechanism by which inter-Tx intermod is generated and re-radiated. We will see
this phenomenon first-hand when we analyze our scenario.

If the input signals to an amplifier exceed the 1-dB point, then EMIT will consider the amplifier to
be saturated and will treat this saturated condition as an interference event. The results will
report the saturated condition of the amplifier instead of an EMI margin.

Add Additional Txs to the Scenario 3-3
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The plotting functionality for an amplifier has some unique characteristics to allow the per-
formance of an amplifier to be easily explored as it is being defined. The plot currently shown in
the amplifier’s configuration dialog should look similar to the one below.

The plot displays the amplifier’s output spectrum due to an input signal consisting of constant
broadband noise and two narrowband tones. This mimics a typical two-tone test which is com-
monly performed on amplifiers to determine their performance. There are two traces on the plot
corresponding to the broadband noise output, labeled Amplifier (Test Noise), and the two-tone
output, labeled Amplifier (Two Tone). Clicking on the legend entries for these two traces will

Add Additional Txs to the Scenario 3-4
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display the respective property panels. In the property panel for the Two Tone trace, you can set
the levels and frequencies for the two-tone test input signal. Similarly, the noise level can be
changed via the property panel for the Test Noise trace. By default, the two tones are placed
about the amplifier’s center frequency, spaced apart by 1 MHz.

Change the parameters for the two-tone test signal to those shown below and observe the
change in the amplifier’s output spectrum on the plot.

With the input signals (tones) at 150 MHz and 200 MHz, we see that in addition to amplified ver-
sions of these signals at the output, there are also a number of undesired intermod products at
other frequencies that are the result of the nonlinear characteristcis of the amplifier. Intermod

Add Additional Txs to the Scenario 3-5
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products such as these can be the cause of serious interference issues in cosite environments
and are often hard to identify.

ClickOK to close the amplifier’s configuration dialog. At this point we are almost done with our
schematic changes. Use the Schematic ribbon to add two antennas to the outputs of Tx-3 (Lo-
UHF) and Tx-4 respectively. Then, double-click on the antenna to open the Coupling Editor and
set the Antenna Noise Temperature = 0 K as we did for the other antennas.

ClickOK to close the Coupling Editor. The schematic should now appear as shown below
(antenna names may be different, but all the antennas are identical so that does not matter).

Add Additional Txs to the Scenario 3-6
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Open the Results dialog by right-clicking on the EMIT Design and selecting Analyze. First, we
are going to examine and mitigate any interference issues associated with the 1-on-1 cases,
when each transmitter is operating alone in the presence of the receivers. Once we mitigate all
of the 1-on-1 interference issues, we’ll analyze all of the transmitters operating simultaneously
and explore any interference problems that result from this N-on-1 situation.

Select the Run icon ( ) to analyze all of the 1-on-1 interactions. The Scenario Matrix should
appear as shown, where we see that Tx-4 is interfering with the RT-2 receiver.

Select the Tx-4 vs RT-2 interaction square in the Scenario Matrix so that the Results Plot cor-
responds to this interaction. Examining the Results Plot, we see that the problem occurs outside
of the receiver’s tuned channel (out-of-channel interference) and is caused by Tx-4’s fun-
damental at 150 MHz. This is quickly identified by looking at the plot marker (black arrow) and its
associated label in the upper right of the plot which specifies the source (origin) of the inter-
ference. Since there is no Rx spurious response at 150 MHz, we can conclude that the 150 MHz
component of the signal that reached the receiver’s antenna port exceeds the saturation level (in
this case +10 dBm) of the receiver.

Add Additional Txs to the Scenario 3-7

Ansys Electromagnetics Suite 2024 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Getting Started with EMIT - Tutorial 3
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This out-of-channel interference can be controlled by placing a bandpass filter on the receiver’s
front-end. Close the Result Dialog via the “X” in the upper right corner. Rename the result node
and add any desired notes.

Disconnect the antenna from RT-2 by dragging the antenna to the left of the radio. Then use the
Schematic ribbon toolbar to add a bandpass filter at the output of RT-2 and reconnect the
antenna to the filter. Double-click on the filter to configure it as shown below.

Add Additional Txs to the Scenario 3-9
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ClickOK to close the filter’s configuration dialog and open the Results Dialog again using one of
the aforementioned methods. Re-run the simulation to see the effects of the added filter. As
seen in the Scenario Matrix, the project is now interference free for all 1-on-1 transmit/receive
pairs.

Now we wish to evaluate the N-on-1 scenarios to see how the system performs when multiple
transmitters operate simultaneously. Looking at the Scenario Matrix, we see that we have 4
transmitters that can operate simultaneously and interfere with Rx-0 and 3 transmitters that can
operate simultaneously and interfere with RT-2.

The entries in the [N to 1] columns for each receiver (row) show the resulting EMI margins for the
receiver when there are N active transmitters in the row transmitting simultaneously. For our cur-
rent scenario, we see that RT-2 does not experience any interference with all the transmitters
operating, but Rx-0 does.

Deselect the N to 1 Combination Limit check box to disable the limit.

Select the Run icon ( ) to analyze all of the N-on-1 interactions.

Select the red Scenario Matrix square and look at the Results Plot.

Add Additional Txs to the Scenario 3-10
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Notice that the Power at Rx (click on the legend entry for emphasis) has many narrowband com-
ponents, far more than just the fundamental and harmonics we defined. This is because the res-
ults are for all transmitters operating simultaneously. For our case, each of our transmitters
operates on only a single channel, but if they had multiple channels, then the results plot display
would show the worst case transmit channel combination.

Before analyzing the above plot in any detail, let’s look at the Interaction Diagram. The Inter-
action Diagram is an extremely powerful tool for determining the source of the issue. With the [N
to 1] vs Rx-0 square in the Scenario Matrix selected, the Interaction Diagram should appear as
below. The orange labels on each transmitter specify the transmit channel that contributes to this
worst case interference and the orange line shows the path that the worst-case interference
takes from the transmitter (or transmitters) to the receiver. As seen in the image below, the 200
MHz channel from the Tx-3 Lo-UHF radio couples into the Tx-4. It then mixes with the 150 MHz
channel from the Tx-4 radio and is re- radiated to the Rx-0 radio where it interferes with the 500
MHz channel.

Add Additional Txs to the Scenario 3-11

Ansys Electromagnetics Suite 2024 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Getting Started with EMIT - Tutorial 3

To get more details on the interference, we can go back to our Result Plot. The plot marker auto-
matically identifies the worst-case interference for the selected receiver, which corresponds to
the red path we just analyzed in the Interaction Diagram. Referring to the plot marker’s label, we
see that the EMI Margin = +26.1 dB and that it is the result of the 2nd harmonic of the Tx-4 fun-
damental (2f1) mixing with the fundamental from Tx-3 (2 x 150 MHz + 200 MHz = 500 MHz).

What we are seeing here is often referred to as inter-Tx intermod. The signal from Tx-3 is coup-
ling into Tx-4. A portion of the coupled signal finds its way to the input of the amplifier based on
the reverse isolation specified for the amplifier. It then combines with the output of Tx-4 at the
input to the amplifier resulting in the problematic third order intermod product at 500 MHz. This is
shown in the figure below. Note that the signal at Rx-0 also includes the direct contribution from
each transmitter (but for clarity this is not shown in the figure).
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The figure above also shows a filter on Tx-4 that we now wish to add. In order to mitigate this
inter-Tx intermod problem, we need to prevent the 200 MHz signal from Tx-3 from reaching the
amplifier on Tx-4. We will add a notch filter to accomplish this as shown.

Close the results dialog by clicking the “X” in the upper right corner. Disconnect the antenna from
the amplifier by dragging it to the left of the amplifier. Select the amplifier and then add a Band
Stop filter from the Filter drop down menu in the Schematic ribbon toolbar. Rename the filter 200
MHz Notch. Select the antenna and click Reposition to connect it to the new band stop filter.

Double-click on the 200 MHz Notch filter and set the parameters as shown below.
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ClickOK to close the filter’s configuration dialog. Verify that your schematic matches the one
below (note: some antenna names may differ, but since the antennas are all identical, it will not
affect the results).

Open the Results Dialog again and re-run the simulation. The Scenario Matrix shows that the
band stop (notch) filter successfully mitigated all the interference as shown by the completely
green Scenario Matrix.
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One more thing to note is that the order of the outboard components is very important. When we
added the notch filter in the previous step, it was added between the amplifier and antenna
which is where we wanted it. However, to see the effect of component placement, move the filter
so that it is located between the radio and amplifier. Re-run the simulation and note that the inter-
mod problems are back. This is because with the filter in this position, the 200 MHz signal from
Tx-3 (and the 50 MHz signal from Tx-1) is not prevented from coupling into the output of the amp-
lifier.
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Move the filter back to its original location and save your project.

Add Additional Txs to the Scenario 3-17

Ansys Electromagnetics Suite 2024 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.


	Table of Contents
	1 - Introduction
	Key Concepts
	Project Configuration

	2 - Add a Transceiver (RT) to the Scenario and Mitigate Interference
	3 - Add Additional Txs to the Scenario

